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Next Meeting 
Tuesday 17 March 2009 

Bairnsdale Bowls Club, corner Pearson and Grant 
Streets. 
7.00pm 

Syllabus Items: 
Repeat of digital photo basics 

Downloading and Installing Irfanview 

Files and photos 

March Award 
All those attending BPCUG’s March meeting 
will have a chance to win a voucher for 20 6x4 
colour prints, donated by Harvey Norman, 
Bairnsdale. 

signed to solve computer-related problems, will 
again be featured. 
In this segment members are invited to explain 
how they have solved the problem described by 
a questioner. 

So popular was the subject of Digital Pho-
tography at the February meeting of Bairns-
dale PC User Group that the topic will be re-
visited at the Group’s meeting on Tuesday 
next, March 17. 
The meeting will be held at Bairnsdale Bowls 
Club, corner of Pearson and Grant Streets, 
commencing at 7.00pm. 
Hand-outs describing the steps involved in re-
sizing digital images, and in changing file for-
mats in Irfanview will be available, with the 
aim of assisting newcomers to this program and 
to digital photography. 
See “Grumphy’s Grumblings” on page 3 for 
more information on these hand-outs. 
The main session at the March meeting will 
demonstrate downloading and installing the 
latest version of Irfanview from the Internet. 
Installing programs from other sources will be 
covered by the installation of IrfanView Plug-
Ins from a CD; and the installation of Mail-
washer from a USB drive. 
The usual “Question and Answer” session, de-

Field Days 
Planning for the Group’s stand at the 2009 East 
Gippsland Field Days, on 1-2 May at Bairnsdale 
Aerodrome is proceeding. 
Entries are being invited in a photographic com-
petition being conducted by the East Gippsland 
Photographic Society, and entry forms are now 
available from the Bairnsdale Visitors’ Informa-
tion Centre in Main Street. 
The venture is being strongly supported by the 
Field Days Committee and by East Gippsland 
Shire Council. 
Assistance in staffing the stand on Friday and 
Saturday, May 1-2, will be required. 
If you are able to assist, please give your name to 
Geoff Mattingley or Ron Yeates. 

Step-by-step help for 
computer users 
Hand-outs to provide step-by-step help in using 
computers are being distributed with this issue 
of “Backup” and the notes will also be avail-
able on the Group’s web site. 
It would be helpful if members could print out 
these notes and bring them to the meeting, as 
they will make it easier to follow the steps be-
ing taken by the presenters. 
The opinion of members about the move to 
provide this material is invited. 



 Ask the Computer Tutor  
Pamela Tabak 
QUESTION 
I was deleting many documents that I did not require. 
At the end I got into trouble with a file called ‘Word 
Viewer.’  I  now  have  three  files  called  ‘Word 
Viewer’ and each icon is somewhat different. Would 
you please advise me what this program is and how I 
can delete it if not required? 
ANSWER: 
Word Viewer is a program that allows you to read 
Microsoft Word documents if you do not have Mi-
crosoft Word installed on your computer. If you have 
the program installed it is not necessary to keep 
WORD VIEWER so you can delete it. If you don’t 
have Microsoft Office or the Word program installed 
I would keep WORD VIEWER so that you can view 
Word documents that may be sent to you by email. 
QUESTION: 
I use often WordPad but now when I open the pro-
gram the WordPad toolbar seems to be missing. 
Bold, underline, align left, center and so on are no 
longer there. How do I recover these features? 
ANSWER: 
The toolbar can easily be replaced by following the 
steps below: 
 Open WordPad 
 Click on VIEW 
 Put a checkmark next to each box, 

TOOLBAR,  FORMAT  BAR,  RULER  AND 
       STATUS BAR.  

Your “formatting” should be restored.  
QUESTION: 
When I type a product in the “search box” the list 
comes up and I select one of the sites to view by 
clicking on the link. When I try to go “back” to the 
search list by clicking on the back arrow the website 
refuses to allow me to do so. Why is this happening 
and how can I remedy this?  
ANSWER: 
This happens when webmasters use a special code to 
stop you leaving their webpage and moving to an-
other site. 
 In order to overcome this annoying occurrence just 
go back to your “search box” and click again to 
search for the product that still remains written in the 
search engine box. It will bring you to the same list 
that you began with.  
QUESTION: 
I had an icon on my desktop for Word but it has dis-
appeared. How can I put it back on the desktop so 
that I can access my Word program quickly?  

ANSWER: 
My advice is to keep the icon on either the “Quick 
Launch Bar” or on the “Start Menu” to prevent the 
loss of this or any other icon that is used to access 
programs quickly but if you really want to keep it on 
the desktop follow the steps below to reinstate the 
icon:  
 Click on START  
 Click on ALL PROGRAMS  
 Locate the program you wish to use from the pro-
gram list and RIGHT click  
 Choose SEND TO and then choose DESKTOP 
     (create shortcut)  
The icon will appear on your desktop  
IMPORTANT NOTE: 
NEVER drag a program out on to the desktop from 
the program list. If you do and the icon disappears it 
will be very difficult to find it again 
Copyright. Reprinted, with permission, from “Bits & Nibbles”, 
magazine of Orange County IBM PC Users’ Group, Brea, Cali-
fornia. 

CAB file fix 
Gordon Giles 
If you have attempted to install a Microsoft Office 
suite in the past and could not complete the task due 
to a missing .CAB file then exit the installation and 
follow the steps below: 
1. Click <Start> <Run> and enter “regedit” and click 
<Enter>. 
2.  Expand  <HKEY_LOCAL_MACHINE> 
<Software>  <Microsoft>  <Office>  <11.0> 
<Delivery> 
3. There should only be one directory under Delivery 
which is your DOWNLOADCODE. This is a series 
of letters and numbers. 
4. Select that directory on the right side of the screen. 
5. Right click on <CD CACHE> and change the 
value to 0 “ZERO”. 
6. Close Regedit and reboot your computer and restart 
your installation. 
7. Remember to get off line and turn off your fire wall 
and virus checker before installing programs. 
8. Reboot after the installation and all your programs 
will be correctly installed. 
Gordon Giles is a member of the Perth PC Users’ Group 
Copyright. Reprinted, with permission, from “AXESS”, newslet-
ter of the Perth PC Users’ Group. 

Bairnsdale PC User Group meets on the third 
Tuesday of each month (except December). 
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Grumpy’s Grumblings 
Due to feedback from a member we have been dis-
cussing the pros and cons of what has traditionally 
been called the “Short Session” at meetings. The 
idea is that we pick a subject and dedicate five to 15 
minutes to it. It might be something simple like how 
to create a new folder, in the right place. It may be 
something more involved like converting a number 
of .JPG files to another graphics format, or resizing 
pictures to send them via the Internet. In other 
words, it could be anything computer-related, basic 
or advanced. The problem is, what to call this time. I 
initially suggested Quick & Dirty. That quickly got 
knocked on the head! What ideas can you come up 
with? Preferably something distinctive that everyone 
will (eventually) associate with our short tutorials. 
Something original and topical would be ideal. 
To accompany the above tutorials we are consider-
ing providing “handouts”. At the March meeting 
they will (probably) be hard copy but it is intended 
that at future meetings they will provided electroni-
cally, either included in (or with) Backup and/or 
available on our web site. I've been deliberately 
vague in that last sentence as we are still in the draft 
stage. Nothing is actually set in concrete yet. In real-
ity providing hard copy at meetings is difficult as we 
never know until the night how many copies are re-
quired. If we print too many it is wasteful, too few 
and some of those attending miss out. Of course, 
anyone unable to attend a particular meeting will 
also miss out. 
Needless to say the format of the documents will 
be .PDF meaning that if you can read Backup then 
you can read the “handout”. It is envisaged that 
these documents will be one, or sometimes, two 

Clasiqe Computer Solutions 
Computer 

sales & repairs 
Printers 

Print supplies 
Scanners 

CD & DVD discs 
29 The Esplanade, Paynesville 

Open Monday to Friday & Saturday mornings 
Phone 5156 6448 Fax 5156 6710 

pages. Maybe we can also come up with a unique 
name for these documents? Ideas, ideas — how 
about coming up with some answers for us! 
One problem we will have is that some presenters 
(both members and non-members) decline to provide 
handouts. That is their prerogative and we can but go 
along with them. Those that do will be asked 
(expected?) to provide the handout to us 10 days 
before the meeting date. This is to allow sufficient 
time to include it in Backup, and/or install it on the 
web site before Backup is distributed to members. It 
is to be hoped that most will be willing to provide 
information that members can review, and use as a 
guide, at home. 
Last month’s discussion on using IrfanView was felt 
to cover too much in to little time. This was a point 
that was reinforced with the aforementioned feed-
back from a member and generated the discussion at 
the Committee Meeting. We may not have paid too 
much attention to this without the input from the 
member. This brings us to another point. The Com-
mittee often has difficulty in deciding what subjects 
to provide during the meetings. Sometimes it is like 
pulling a rabbit from the hat. A bit of guidance from 
you, the members, will help us. If you have any 
ideas or suggestions please advise a Committee 
member. Preferably do not just whisper in their ear 
at the meeting break, send an email message. Meet-
ings often are quite busy times for Committee mem-
bers and it is all to easy for your comments to disap-
pear into the ether. Sending an email message makes 
sure that your idea gets an airing at the next Com 

(Continued on page 4) 
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Web Wanderings 
tionised photography. We're all taking more photos 
than ever. 
For the most part, this is great. It allows us to save 
more precious memories. We can also share them 
easily with family and friends. 
So, what's the drawback? It's difficult to manage hun-
dreds or even thousands of photos. Trust, me, I know! 
My computer is teeming with photos. 
Fortunately, you can get help managing your photos. 
Just download the free Snapact Photo Manager. 
This handy program will help you add descriptions 
and keywords to photos. This will make it easier to 
find your photos. 
You can also create photo albums and perform minor 
photo edits. Then, upload your photos to Snapact's 
free image-hosting service. 
Getting organised was never so easy! 
www.komando.com/downloads 
HOW OLD ARE YOU? 
Age is nothing but a number, or so the expression 
goes. Believe it or not, there is truth in this expres-
sion. 
You see, there are things you can do to make yourself 
feel and look younger. Other behaviours can cause 
you to age faster. 
That's the concept behind RealAge. At the RealAge 
Web site, you can calculate your age based on your 
behaviours. 
All you need do is answer a quick questionnaire. You 
may or may not like the results. In that case, it is time 
to take action. 
RealAge has plenty of tips to help you improve your 
health — and your life. You'll find advice for eating 
better and exercising correctly. 
You'll also find information on health conditions. Or, 
meet up with others on the message boards. 
www.realage.com 
WORLD NEWSPAPERS ONLINE 
Just put your mouse on a city anywhere in the world 
and the newspaper headlines pop up... Double click 
and the page gets larger.... This site changes every 
day with the publication of new editions of the paper. 
Also, if you look at the European papers, the far left 
side of Germany will pop up as The Stars & Stripes 
(European edition, of course). 
www.newseum.org/todaysfrontpages/flash/ 
COLLABORATE ONLINE 
You may have heard about cloud computing. It's the 
latest technology trend. Many people don't understand 

(Continued on page 5) 

TESTING YOUR NETWORK CONNECTION 
It's no secret that some Internet providers interfere 
with data traffic. Comcast was recently at the centre 
of a controversy over traffic throttling. 
Service providers have many tools at their disposal. 
For example, they can give some Internet traffic pri-
ority over other data. 
This can, of course, work to your advantage. For 
example, you want a high priority for your VoIP 
(Voice over Internet Protocol) calls. That way, your 
conversations wouldn't be garbled. 
Unfortunately, some providers may not play nicely. 
VoIP traffic may be given a low priority. That way, 
subscribers may sign up for that ISP's phone plan. 
So, how do you know if your provider is throttling 
your traffic? That can be difficult to determine. But I 
have some tools that may help. 
M-Lab offers a variety of tools to help test your 
Internet connection. You can see if there are prob-
lems limiting your speed. Or, see if BitTorrent is 
being blocked or slowed down. M-Lab is working 
on more tools for troubleshooting connections. 
Only so many users can access a specific tool simul-
taneously. So, you may get a connection error. If so, 
wait and try again. 
You'll also want to bookmark the site. That way, 
you can return to the site if you notice an Internet 
slowdown! www.measurementlab.net 
TAME YOUR PHOTO COLLECTION  
There's no doubt that digital cameras have revolu-

mittee Meeting. The recipient should also respond to 
you with the outcome, at least in principle. Users 
helping Users? Members helping Committee is more 
like it! 
To see how all this goes Tuesday night will see an-
other session on using IrfanView but covering only 
one procedure, supported by a handout. Your 
thoughts will be appreciated. There is one problem 
that this may cause and that is if you are using an-
other graphics program. Whilst the overall function 
may remain the same, the way of accessing that 
function may well be different. It will be up to you 
to work that out! No one of us is an “expert” on 
every program that exists. 
See you all Tuesday evening, 

Geoff Morgan 
President, BPCUG 

Grumpy’s Grumblings 
(Continued from page 3) 
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Effective blog posts 
tionally posting inaccurate or false information will 
significantly damage a blogger’s reputation. But if an 
error unintentionally or inadvertently occurs in a blog 
post, be sure to quickly post a retraction or correction, 
along with an explanation and an apology.  

4. Relevant and timely — Blog posts should always be 
relevant and timely. Hearing about something long 
after it has occurred will not captivate readers. Blog 
about information that is occurring here and now. If 
you are going to write something that is no longer 
timely, be sure to add some sort of twist, or include 
new or updated information.  

5. On topic — All blogs should have a general theme 
that connects all the posts on the blog. Readers will 
expect posts that are related, so stay true to the blog’s 
theme and topic.  

6. Use keywords — Use keywords liberally in blog 
posts. Search engines will attempt to categorise the 
content of a blog post and discern its general topic. By 
including related keywords or keyword phrases, search 
engines will have an easier time classifying the blog’s 
contents. A blog that uses keywords will have a better 
chance of ranking well in organic search listings. 

7. Evaluate web logs — Review web logs to determine 
what blog posts have been popular with readers. Then 
figure out how to provide similar or related content 
that might also be of interest to those readers. 

8. Original — Blog posts should always contain origi-
nal and unique content. If you are simply reposting 
information from others, include editorial content or a 
different spin to the information. Readers do not want 
to rehash the same information — they are interested 
in reading new material. 

9. Chunky content — Break content into smaller, read-
able chunks. Most website visitors will just scan para-
graphs for information, and very few will take the time 
to read all the words contained in a post. Use bulleted 
lists, or break web copy into paragraphs with boldface 
subtopics before the paragraphs.  
Sharon  Housley  manages  marketing  for  FeedForAll  http://
www.feedforall.com software for creating, editing, publishing RSS 
feeds and podcasts. In addition Sharon manages marketing for 
RecordForAll  http://www.recordforall.com audio recording and 
editing software. 
Copyright. Reprinted with permission from the author. 

Invite a new member to join BPCUG! 
Membership application forms are available 
from the Secretary. The more members we 
have, the stronger the Group will be. 

cloud computing. But most of us have used cloud-
computing for years. 
The concept is simple. Programs and data are stored 
online, not on your computer. You can log in and 
begin working no matter where you are. 
Hotmail and Yahoo! Mail were early cloud-
computing programs. E-mail is the most common 
type of cloud-computing program. But you can do 
other cool things in  the cloud. 
For example, look at Writeboard. This site lets you 
create free writeboards. These are basically word-
processing documents. 
Writeboards can be shared with others for easy col-
laboration. Every edit is saved. That means you can 
roll back to an earlier version if needed. 
Of course, you can access your Writeboards from 
anywhere. For many, this is  the real draw of cloud 
computing.  
Give it a try — you'll love it! www.writeboard.com 
Copyright. Reprinted, with permission, from the newsletter of 
the Central Coast Computer Club, Santa Maria, California. 

Web Wanderings 
(Continued from page 4) 

Sharon Housley 
Blogs are now a dime a dozen, and bloggers need 
to make their blog posts stand out. Developing a 
blog following is not as easy as it once was. 
Learn how to write blog posts that attract read-
ers  and  retain  their  attention.  Follow  these 
guidelines to cultivate readers and to produce a 
relevant blog worth reading.  

1.  Draw  attention  —  Use  titles  to  attract  the 
reader’s attention to the blog post. The title should 
mimic newspaper headlines and generate interest in 
the blog post. The title can be controversial, but not 
to the extent of being misleading. Use action words 
in the title.  

2. Deliver — Having a catchy title, but following it 
with content that fails to deliver, will not endear 
you to your readers. The blog content must deliver 
what is promised in the blog title, or readers will 
unsubscribe and stop reading. When deciding on a 
blog title, do not stray too far from the content, as 
the two are intricately related — the title will attract 
the reader’s attention, but the content must then live 
up to expectations.  

3. Accurate — Nothing stains a blogger’s reputa-
tion like inaccurate information, so be sure that 
your blog posts contain accurate information. Inten-
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New template in Word 

Invite a new member to join BPCUG! 
Membership application forms are available 
from the Secretary. The more members we 
have, the stronger the Group will be. 

5. Close MS Word and open Windows Explorer by 
right  clicking  the  start  button  and  selecting 
“Explore” 
6. You will need to follow the next steps in the cor-
rect order. Select the “C: drive” and then “Programs 
and Settings”. 
7. Select the name you have activated your com-
puter under. 
8. Next select “Application Data” and “Microsoft” 
then select “Templates”. 
9. Only do the next step if you want a totally new 
default page. You would probably want option (B) 
if you have added an address or some text on the 
default page. 
10. (A)Remove the file “Normal.dot” and edit the 
one you saved to Normal.Dot. Close all windows 
and restart MS Word and you will have your new 
default page. 
11. (B) If you have entered text on the new saved 
file then open MS Word and click on new on your 
right. You will see a list of templates. Just click on 
“Normal2.dot” and you will have your new tem-
plate on the screen. 
Gordon Giles  is a member of the Perth PC Users’ Group. 
Copyright. Reprinted, with permission, from “AXESS”, news-
letter of the Perth PC Users’ Group. 

Vista memory test 
Investigate  Ram  Problems  by  launching  the 
VISTA Windows Memory Diagnostic Tool 
If you’re encountering application failures, operating 
system faults, or Stop errors in Windows Vista, you 
could have defective or failing RAM. 
Microsoft included the Windows Memory Diagnos-
tic Tool in Windows Vista so that you can test the 
RAM chips in your system.  
There are actually several ways that you can launch 
the Windows Memory Diagnostic tool. The method 
you will use will depend on your situation.  
If you are experiencing intermittent problems but can 
still boot into Vista, you can launch the Windows 
Memory Diagnostic tool by clicking the Start button, 
selecting Control Panel, and clicking the System and 
Maintenance icon. When you access the System and 
Maintenance window, select Administrative Tools. 
Then, click the Memory Diagnostics Tool icon.  
Alternatively, you can click the Start button, type 
Memory in the Start Search box, and then click the 
Memory Diagnostics Tool icon. Either way, you’ll 
encounter a UAC and will need to respond accord-
ingly.  
When you see the Windows Memory Diagnostic 
Tool dialog box, click the Restart Now and Check 
for Problems option. When you do, the dialog box 
will close and your system will automatically restart.  
When you see the Windows Memory Diagnostic 
Tool dialog box, click the Restart Now and Check 
for Problems option. When you do, the dialog box 
will close and your system will automatically restart. 
Copyright. Reprinted, with permission, from Bearly Bytes, news 
Big Bear Computer Club, Big Bear City, California. 

Gordon Giles 
Have you found it rather annoying to open MS Word 
and have to alter the text font and size and maybe 
alter other things before you start? This method can 
be set as the default method or just a template for use 
when selected. 
1. Open MS Word and alter any setting. Maybe the 
way you view a document, the font and size and the 
percentage size of the screen view. 
2. If you wish enter a header with your name and 
address in it. Remember though, that’s what will be 
on the page next time you open MS Word. 
3. Next click on “File” and “Save As” select in the 
“Save as Type” Box “Document Template (*.Dot) 
and name the file “Normal2.dot”. 
4. Now click on Save. 

Windows Tip  
By Norene Lieser  
Make Your Folders Private  
Open My Computer  
Double-click the drive where Windows is in-
stalled (usually drive (C:), unless you have more 
than one drive on your computer).  
If the contents of the drive are hidden, under Sys-
tem Tasks, click Show the contents of this drive.  
Double-click the Documents and Settings folder.  
Double-click your user folder.  
Right-click any folder in your user profile, and 
then click Propreties.  
On the Sharing tab, select the Make this folder 
private so that only I have access to it check box. 
Copyright. Reprinted, with permission, from Bearly Bytes, news 
Big Bear Computer Club, Big Bear City, California. 
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you can find Properties. Once you’ve found the 
properties box, look through the various tabs until 
you see a short list of choices that includes Draft. 
Mark that choice, then click OK as many times as 
necessary to get back to the usual Print dialogue. 
Depending on your printer, you may or may not 
need to revisit the printer properties and change the 
setting back to normal before you print a document 
with pictures. This will depend on your particular 
printer driver — some keep the latest settings, some 
go back to default at the end of each session. 
Bear in mind, also, that while some pictures are 
purely decorative, some are an essential part of a 
page which won’t make lots of sense without them.  
Always look at the Print Preview. 

This not only lets you know if there are more pages 
than you’d anticipated, but it also lets you check that 
the page is going to fit properly. 
Clicking the small arrows will move you forwards or 
backwards through the preview a page at a time. 
Clicking the double arrows will take you to the end 
or the beginning of the document. 
To go to a particular page, type its number into the 
page number box and hit enter. 
Clicking the drop down arrow beside the box that 
here says 75% lets you choose a different view. If 
you choose 50% you’ll see the whole page (actually 
you’ll see two pages) from top to bottom. 
Clicking one of the two magnifying glass symbols 
will give you a bigger or smaller view. 
Clicking the word Print at the left end of the bar will 
open the print dialogue box, print preview setup but-
ton. 

  You get to Page Setup, where margins and 
  orientation can be changed, by clicking 
  this button, which is just to the right of 

Print on the Print Preview menu bar. 
If the page is obviously not going to fit, try adjusting 
the margins. 
Occasionally a page is so wide that you’ll need to 
change the page orientation from Portrait to Land-
scape. 
Opening the print preview window. 
When you are looking at a web page, to get to Print 
Preview you click on the File menu and then on 
Print Preview. 
Some web pages have a button you can click to take 

(Continued on page 8) 

Printing web pages 

Disclaimer 
All material published in this newsletter represents the opinions of 
the authors and does not carry any endorsement by the editor or the 
management committee. We do not have the resources to test 
programs or tips that are published here, so use them at your own 
risk. The Bairnsdale PC User Group Inc. has no official connection 
with any public or commercial organisation and does not provide 
product recommendations. Names of commercial products mentioned 
in this newsletter are the registered names and trademarks of their 
owners. The editor reserves the right to reject any articles or 
advertisements. All display advertisements must carry the full trading 
name/s and address of the advertiser. Copyright remains with the 
author. Permission to re-print articles is granted to other non-profit 
computer user-groups, provided credit is given to the author and 
BPCUG. 

Fay Johnston 
When printing web pages, print size is affected by 
viewing size 
This is an annoying feature of Internet Explorer. If 
you find the text on a web page too small to read 
comfortably, and therefore click View > Text Size 
and choose Larger or Largest, any printing you do 
may be correspondingly enlarged. Not only that, but 
if you print out an email from Outlook Express, that 
will also use a large font. That’s just one more rea-
son for always checking Print Preview. 
You can choose to print just one page. 
You don’t have to print seven or eight pages just to 
get one recipe or one photograph. Go to the Print 
Preview, click through the pages until you see the 
part you want to print and make a mental note of the 
page number. Then, after you’ve clicked “Print,” 
type that number into the “Pages” place. There’ll be 
two boxes, one marked “from” and the other “to”. If 
you want to print just page seven, for instance, you 
type a 7 into each of those two boxes. 
Make sure that you print only the page and not 
its background. 
To ensure that this happens:  

1. Click on Tools on the browser menu bar. 
1. Click on Internet Options.  
3. Click the Advanced tab.  
4. Scroll down until you see a printer icon.  
5. Make sure that “Print background colours and 

          images” is not checked.  
6. Click OK. 
This won’t affect the printing of pictures or dia-

grams that are part of the actual page. 
If you do want to leave those out as well, click 
Print, but when the print dialogue appears, don’t 
click OK. Instead, look for a button marked Prop-
erties. It’s often near the top right-hand corner of the 
box. If it isn’t there, there may be a box marked 
Setup, and clicking this will take you to a box where 

Backup 7 March 2009 



Double-click My Computer and then right-click the 
hard disk drive that you want to check. 
Click Properties and then click Tools. 
Under Error-checking click Check Now. 
Click Start. 
Add familiar icons back to your desktop 
It's the case of the missing icons. Many of you may 
be wondering where all the icons from your desktop 
are in Windows XP? You can place at least My 
Computer, My Network Places and My Documents 
on the desktop. 
Right-click on the desktop and then click Properties. 
Click the Desktop tab and then click on Customize 
Desktop. 
Put a check mark in the box next to My Document, 
My Computer, My Network Places or Internet Ex-
plorer, to add those familiar icons to your desktop. 
How to find your IP Address in Windows XP 
Start and click Run Type "cmd" (without quotes) 
and hit enter Once the box opens type "ipconfig /
all" (without quotes) and hit enter. 
Copyright. Reprinted, with permission, from the newsletter of 
the Central Coast Computer Club, Santa Maria, California. 

Four tricks 

you to a printer friendly version. This is usually a 
version without extras, like menus or unnecessary 
pictures. 
make your own copy 
If you see useful information spread over too many 
pages, you can always copy and edit it before you 
print. Definitely the best way to collect recipes! 
Paste them all into one document, one after the 
other, or in categories. 

*Click just before the part you want begins, hold 
     Shift while you scroll down and click after the 
      end of the part you want. 

* Hold down the Ctrl key and tap “c”. 
* Open Notepad or some other text editor, or your 

        word processor. 
*  Hold down the Ctrl key and tap “v”. 
*  Save with a name of your choice, then edit and 

       print. 
Note, though, that pictures will not be included, and 
if you paste into a word processor, any links will 
usually be lost. 
Fay Johnston lives in Australia and has many other helpful tips 
on her website at http://fay.iniminimo.com 

Copyright. Reprinted, with permission from the author and from 
“Bits & Nibbles”, magazine of Orange County IBM PC Users’ 
Group, Brea, California. 

Printing web pages 
(Continued from page 7) 

Ron Broadhurst, Space Coast PC Users Group, FL 
www.scpcug.com shiron (at) cfl.rr.com 
Customise the Start Menu 
The Start menu gets more real estate in XP than in 
previous versions, and it's more customisable. To 
make the Start menu display only the applications 
you want, rather than the default determined by Mi-
crosoft: 
Right-click in an empty section of the Start menu's 
left column. 
Select Properties > Start Menu > Customize. Here 
you'll find a list of your most frequently used pro-
grams. (XP keeps track of what you use and what 
you don't, then updates this list dynamically). 
Don't want your boss to know that Pinball, Solitaire 
and Quake all make your list? Go to the General tab, 
click Clear List, and set the counter to zero. 
How to perform disk error checking in 
Windows XP 
This describes how to check the integrity of the hard 
disk drive in WindowsXP. After you install Win-
dows XP, the Scandisk command is not available. 

Quick Access to Frequently 
Used Documents 
If you are like me, there are a couple of documents 
that you access frequently, like letterhead templates, 
form letters or anything that you constantly re-use. 
If one of them is the last four documents that you 
accessed, it will show up in the recently accessed 
list when you click on the File menu in Microsoft 
Word, but if not, you are back to accessing it manu-
ally. 
Word has an option to add a "Work" menu to your 
toolbar that will only contain the documents you 
want quick access to at all times: 1. Click on the 
View menu, then on Toolbars, then on the Com-
mands tab and select Built-in Menus from the list. 
2. Click and Drag "Work" from the list of com-
mands to where you want it on the Top Line menu 
(dropping it next to the Help menu is the easiest). 
3. Open any document you want to add, click on the 
newly added "Work" menu, then on "Add to Work 
Menu" To remove documents, press Ctrl-Alt- Mi-
nus (which will turn your cursor into a large minus 
sign) then click the Work menu and select the file-
name you want to remove! 
Copyright. Reprinted, with permission, from the newsletter of 
the Sunland Village East Computer Club, Arizona. 
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Interesting questions 
bar and Start option window is displayed. By care-
fully studying (and playing with) all these options, 
you can learn a lot about the Taskbar. 
However, you won't be able to change much until 
you "Unlock the Taskbar" in the first pop-up list of 
options. 
To learn more about the Taskbar, go to Help and 
Support / Inbox, and search for "taskbar". 
We also discussed the fact that Windows is a "multi-
tasking" system. This means you can have many 
programs running at any one time. They will show 
on the taskbar, but it may get crowded. 
One way to help this is to double the height of the 
Taskbar by placing the mouse cursor over the top 
edge (a double arrow will appear), and with the left 
mouse button drag the arrow up until the Taskbar 
doubles. 
The reverse will shrink the Taskbar. You can also 
"group" similar icons by choosing this option in the 
Taskbar Properties window. 
There was a question of formatting a flashdrive. 
They can be formatted the same way we used to for-
mat floppy disks — right click the drive and choose 
Format. 
It was mentioned that any time you make a change 
to the operating system (and sometimes to applica-
tions) it is a good idea to restart Windows. 
Usually changes to the registry are not effective until 
the system is restarted in order to put the disk ver-
sion of the registry into memory. 
Copyright. Reprinted, with permission, from the newsletter of 
the Central Coast Computer Club, Santa Maria, California. 
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Dick Trissel 
A couple of interesting questions came up at a re-
cent Central Coast Computer Club Systems S.I.G. 
One question was how to change the size of the 
icons in the taskbar (the section across the bottom of 
the system window.) One suggestion was to change 
the resolution of the screen display from a high 
resolution to the 800X600 option. 
The Quick Launch icons can be made larger with 
the following procedure: 
Right-click on the Taskbar and deselect "Lock the 
Taskbar", then right-click on the left side of the 
Quick Launch menu and then on the View menu to 
select the "Large icon" option. If you want to lock 
the Taskbar, right-click on the Taskbar once again 
to reselect the "Lock the Taskbar" option to lock it 
in place. 
Then there was the question of how to change the 
display font size.  One way is to right-click the 
Desktop, click Properties /Settings / Advanced and 
change the DPI Settings option. 
Speaking of Taskbars, we discussed the four sec-
tions of a standard Taskbar — from left to right 
there is the Start button, the Quick Launch area, the 
task area (running programs), and the Systray area 
(also running programs). 
The Taskbar properties can be adjusted by right-
clicking in an open area of the Taskbar (not in an 
icon). This will pop-up a list of options, one of 
which is Properties. Click on Properties, and a Task-

Windows Tip  

How to navigate the 
Taskbar without a 
mouse  
Norene Lieser  
If you find yourself using Windows without a mouse 
or you just prefer using the keyboard for task switch-
ing, here are the key combinations you will need:  
Control + Esc  
Esc  
Tab  
Now you can use the left and right arrows and the 
tab key to navigate the taskbar. 
Copyright. Reprinted, with permission, from Bearly Bytes, news 
Big Bear Computer Club, Big Bear City, California. 
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Alternative browsers 

ExtremeSpeed ADSL 2+ Broadband 
ADSL Broadband 
Wireless Broadband 
Web Hosting 
VOIP Telephone Solutions 

Gippsland's Own Internet Company 

The support of Wideband Networks in 
providing BPCUG’s Wireless Internet 
Connection is gratefully acknowledged. 

Phone 1300 731 821 
www.wideband.net.au 

Ira Wilsker 
WEBSITES: 
http://www.getfirefox.com 
http://www.opera.com 
http://www.apple.com/safari 
http://www.google.com/chrome 
Windows users are all too well aware that contem-
porary versions of Windows come complete with 
Microsoft’s Internet Explorer (IE) installed in such a 
way as it is almost impossible to remove. Because 
Microsoft  initially makes IE the default  browser, 
many users are unaware that there are some excellent 
free alternatives out there that are often more feature 
rich and use fewer resources than IE. Many of the 
current crop of web based malware target the insecu-
rities (and mass distribution) of IE, a vulnerability 
often lacking in the alternative browsers. According 
to some published statistics,  the market share of  
users using IE as their primary browser has recently 
dropped to 70%, compared to a near monopoly just a 
few years ago. Perhaps users are smartening up, and 
learning that there are quality alternatives to IE that 
may provide a better and more secure browsing and 
web surfing experience. 
My personal favorite browser, that I admittedly use 
in excess of 95% of the time on all of my computers, 
is Firefox, recently released as version 3.07. After IE, 
Firefox is currently the most widely used alternative 
browser in the world. Available for almost all plat-
forms (operating systems), and published in almost 
every language in the world, Firefox is produced as 
“open source” software,  where anyone is free to 
write add-ons, plug-ins, or other enhancements to the 
software. Because of this open source concept, there 
may be more ways to customise Firefox than any 
other browser. While I choose to run several Firefox 
plug-ins  and  add-ons,  Firefox  is  just  fine  as 
downloaded. Firefox is written in very tight code, 
which makes it a much smaller download than IE, 
and typically uses less system resources and is faster 
to load and open web pages than IE. Of the major 
browsers, Firefox was a pioneer of tabbed browsing, 
a feature that was not offered in IE until recently. 
When people tell me that they are having trouble 
with IE, my typical initial response is to download 
and install Firefox. With a few exceptions, Firefox 
works well when IE seems to choke. One nice fea-
ture  when  Firefox  is  installed  is  that  it  non-
destructively imports data from IE, such as cookies, 
favorites (bookmarks), stored passwords, and other 
information from IE, making Firefox quick and easy 
to use. IE and Firefox can mutually co-exist on a 
computer and not interfere with each other. While 
each may ask to make it the default browser, my 

clear choice between IE and Firefox would be for 
Firefox. 
Another alternative browser, which would also be 
an excellent choice, is Opera, a Norwegian browser 
that is immensely popular in Europe, and gaining 
in popularity elsewhere. Opera claims over 20 mil-
lion registered users.  The latest version is 9.64, 
and is faster, more secure, and more feature rich 
than IE. Opera is  available in many languages 
(including English), and for most platforms, includ-
ing computers,  cell  phones,  PDAs, and gaming 
consoles. Opera utilises a lot of innovative features 
unavailable on most other browsers, especially IE. 
Some of these unusual but beneficial features are 
“Mouse gestures” where scrolling the mouse may 
be  used  to  switch  between  web  pages;  “Page 
zoom” where the view of web pages can be modi-
fied to meet personal preferences; “Fast forward” 
which advances to the next page of many popular 
sites such as Google and Facebook; “Rewind”, the 
opposite of “fast forward”, allows the user to scroll 
back  to  previous  pages  on  selected  websites; 
“Trash can” where previously viewed but closed 
web pages and tabs can be re-opened; “Magic 
wand”  which  will  automatically  fill  in  online 
forms; and many other helpful and unique features. 
For those who want a full featured browser that is 
faster and more secure than IE, Opera would be a 
good choice. 
Apple, which has been producing its own proprie-
tary browser, Safari, for Apple computers, released 
a PC version last year, now in version Beta 4. Re-
cent published performance comparisons between 
Safari and other browsers appear to show that Sa-
fari is the fastest major browser on the market, ca-

(Continued on page 11) 
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Alternative browsers 
and is written in very tight code to make it fast to 
execute and load web pages. While Chrome is a very 
attractive browser, I will have to reiterate what I said 
when I first reviewed it last year, when I called it 
“not ready for prime time”. I downloaded a fresh 
copy of Chrome directly from Google for this col-
umn, and installed it. The download and install was 
fast and efficient, as it also imported my favorites 
and bookmarks from IE, enabling instant use. When 
I went to use it, just as I had done about a year ago, 
several of the web pages I routinely use would not 
display, instead showing a black screen that says, 
“Aw Snap! Something went wrong while displaying 
this webpage. To continue, press reload or go to an-
other page.” This error occurred on my Yahoo web 
mail page, My Yahoo, and even on my weather page 
which is written in plain HTML. Because of the in-
ability to display these pages, Chrome is the only of 
the browsers above that I have installed and then un-
installed on my computer. I will try it again when the 
next major update is released, but will not use it until 
then. 
There are some excellent alternative browsers avail-
able that may be superior to the ubiquitous IE in fea-
tures, speed, and security. All of these browsers are 
free, and worthy of a try. To quote the old TV com-
mercial, “Try it, you’ll like it!” 
Copyright. Reprinted, with permission of the author, Ira Wilsker 
[iwilsker@sbcglobal.net] 

pable of loading and displaying web pages several 
times faster than IE, and faster than its other major 
competitors. Safari claims to be an elegant browser, 
much more appealing to the eye than IE, with a 
much cleaner front end.  Safari takes up less desk-
top space than IE, allowing for more of a webpage 
to be displayed without Safari crowding out the 
webpage with borders, toolbars, and other distrac-
tions. 
Safari includes an integral spell checker to improve 
what the user displays in blogs and other postings, 
and was the first major browser to integrate an RSS 
feed directly into the browser. For those who want a 
feature rich and cutting edge browser, that is cur-
rently the fastest on the market, and very pleasing 
to the eye, Apple’s safari would be a good choice. 
As with the other browsers, Safari can co-exist with 
other browsers on the same computer without inter-
fering with each other. 
About a year ago, Google introduced its feature rich 
browser, Chrome, which was designed from the 
ground up to be a leading browser that integrates 
well with Google’s other abundant features and ser-
vices. When it works, it is very impressive, and of-
fers active thumbnail images of recent web pages 
visited, and interactive searches from the address 
bar. As with the other alternative browsers, Chrome 
will import favorites and other information from IE, 

(Continued from page 10) 

This and That 
Lynn Page 
Windows Mail 
Newsgroups 
Newsgroups are Internet discussion forums for us-
ers with common interests to talk about their inter-
ests. Newsgroup messages can be read by anyone 
who views the group that where t they are posted. 
Newsgroups are international in scope, with partici-
pants from all corners of the Internet. Windows 
Mail provides a newsreader to download messages 
from a news server. Many ISPs offer access to news 
servers containing thousands of groups covering a 
wide variety of topics. 
Spam 
The junk email filter in Windows Mail is designed 
to catch obvious spam and move them to a Junk 
email folder. Increase or decrease the junk email 
protection level based on how much junk email you 
receive. 
Windows Vista 
User Accounts 
A user  account  is  information  telling  Windows 

what files and folders the user can access, what 
changes to the computer can be made, and user per-
sonal preferences, like desktop background or color 
theme. 
With User accounts a computer can be shared by 
several people, who still have their own files and 
settings. Each person accesses their user account 
with a user name and password. 
User accounts can be Standard, Administrator or 
Guest. Each type gives a different level of control 
over the computer. The standard account is the ac-
count to use for everyday computing. The adminis-
trator account provides the most control over the 
computer. The guest account is primarily for people 
who need temporary access to the computer. 
Use a standard account to help protect your com-
puter by preventing users from making changes that 
affect everyone who uses the computer. Create a 
standard account for yourself and each additional 
user. 
Copyright. Reprinted, with permission, from the newsletter of 
the Crystal River Users’ Group, Crystal River, Florida. 
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Managing XP 
Dick Trissel 
The following dissertation is for those people who 
want to understand some of the intricacies of the XP 
operating system, and to help them better manage 
their computer. These comments apply somewhat to 
Vista. 
The Microsoft Management Console (MMC) is an 
application that hosts administrative tools. By itself, 
MMC performs no administrative services. Rather, 
it acts as host for one or more modules called snap-
ins. The snap-ins do the useful work. MMC simply 
provides user-interface consistency so that you or 
the users you support see more or less the same style 
of application each time you need to carry out some 
kind of management task. The combination of MMC 
with one or more snap-ins is called an MMC con-
sole. MMC consoles have, by default, the exten-
sion .msc, and .msc files are associated by default 
with MMC. A console is listed as a type Microsoft 
Common Console Document. 
Thus you can run any MMC console by double-
clicking its file name in a Windows Explorer win-
dow or by specifying the file name on a command 
line.  The  MMC  consoles  are  located  in: 
C:\Windows\System32. 
MMC consoles can be run in author mode or in 
three varieties of user mode. 
Author mode gives you full access to MMC's menus 
and options. In its user modes, elements of MMC's 
functionality are removed. To run a console in au-
thor mode, right-click it in a Windows Explorer 

window and choose Author from the shortcut menu. 
Alternatively, you can run a console in author mode 
using  the  following  command-line  syntax: 
name.msc /a where name is the filename of the con-
sole file. 
The following is a list of Microsoft Management 
Consoles (MMC) located in XP (the Vista list is 
similar): 
C:\Windows\System32: 
certmgr.msc   Certificates - Current User 
ciadv.msc   Indexing Service -  System Vol-
ume Information 
compmgmt.msc Computer Management - System 
Tools, Storage, Services devmgmt.msc    Device 
Manager 
dfrg.msc   Disk Defragmenter 
diskmgmt.msc  Disk Manager  
eventvwr.msc  Event Viewer - Application, Secu-
rity, System 
fsmgmt.msc  Shared Folders (Local) 
gpedit.msc   Local  Computer  Policy  -  Com-
puter Config, User Config 
lusrmgr.msc  Local  User  Groups  -  Users, 
Groups 
ntmsmgr.msc  Removable Storage (Local) 
ntmsoprq.msc  Removable Storage Operator Re-
quests 
perfmon.msc  Performance Monitor 
rsop.msc   Resultant  Set  of  Policy -  Com-
puter Config, User Config 
secpol.msc   Local Security Settings 
services.msc  Services (Local)  
wmimgmt.msc Windows Management Infrastruc-
ture (Instrumentation) 
C:\Windows\System32\Com: 
comexp.msc  Component Services     
Copyright. Reprinted, with permission, from the newsletter of 
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BPCUG Membership 
Annual subscription details: 
Individual membership: $22 per year (includes 
“Backup”, the Group’s monthly newsletter). 
Family Membership: $25, plus $2 for each additional 
family member, entitling each family to one copy of 
“Backup” and giving each family member all other 
Group privileges. 
Student membership: $11. 
Please forward your application for membership, 
enclosing subscription, to Mr Bryan James, 
Membership Officer, Bairnsdale PC User Group, 56 
Rupert Street, Bairnsdale 3875. 

Help..... 
One of the principal aims of Bairnsdale PC User 
Group is to assist all owners of computers to gain 
the maximum benefit from their investment in 
technology. 
The following Bairnsdale PC User Group members 
(programs in which they are knowledgeable in 
brackets) offer their help and advice to members 
who experience hardware or software problems : 
Terry Horne (General)   5157 1230 
Colin Laurence (electronics & engineering)  5152 5005 
Geoff Morgan (General)   5155 1865 
Ian Wickens (NewUusers)   5156 0437 

Ron Yeates (DOS, MS Publisher, general)   5152 4059 
As a matter of courtesy, please confine your calls 
for assistance to reasonable hours (say, 9.00am-
9.00pm). See “Help /Guidelines” (available at 
BPCUG meetings)  
To be included on this list, send an e-mail to Ron Yeates, or 
hand in the address at the next BPCUG meeting. 

Backup 12 March 2009 


